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Overview 

This tutorial is optimized for Echoview 15 and provides an introduction to Echoview.  

This tutorial is not intended as a comprehensive user manual.  

Further information on Echoview tools and topics can be found in the latest version of the Echoview help file. 
This can be viewed online and is installed with Echoview. Press F1 when using Echoview to open the help file 
and read context-sensitive information. 

Throughout this tutorial further reading is referred to the Echoview help file or other Echoview learning 
materials: https://www.echoview.com/support 

Prerequisites 

This tutorial assumes you have Echoview installed, and the following skills and knowledge: 

• Familiarity with a supported Microsoft Windows™ operating system. For more information refer to the 
Computer requirements page of the Help file.  

• A basic understanding of echosounding techniques and hydroacoustic surveying. For more information, 
see texts such as Fisheries Acoustics (Simmonds and MacLennan, 2005, Blackwell Science, Oxford.). 

Echoview modules  

This tutorial requires a license with the Essentials module. If you do not yet have access to an Echoview 
license with this module, please contact info@echoview.com. Solution files are also included in the tutorial 
package to allow you to see the results of module-protected capabilities. Within the solution EV file, Marker 
regions indicate tutorial selection areas. 

Contacting Echoview 

For assistance with this tutorial please contact support@echoview.com. 

Set up 

We recommend extracting or copying the tutorial files to C:\Echoview Software\Tutorials\. If the files 

are not in this folder, use Windows Explorer to search for them. If they are not loaded on your machine, 
download and reinstall the tutorial from www.echoview.com or from the Echoview USB drive. 

Troubleshooting 

If you receive a message saying that the version of Echoview you are running cannot read the file you have 
opened, you may be running an old version of Echoview. You can download the latest version of Echoview 
from www.echoview.com.  

 
  

https://www.echoview.com/support
mailto:info@echoview.com
mailto:support@echoview.com
http://www.echoview.com/
http://www.echoview.com/
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Topic 1: Understanding Echograms 

In this topic you will learn:  

• about the main features of the Echoview echogram window 

• how to use the basic features of the Echoview echogram window to view data 

Overview of echograms 

An echogram is a pictorial representation of the water column (vertical axis) recorded by an echosounder as a 
function of time (horizontal axis). Each vertical column of pixels in the echogram represents an individual ping. 

In Echoview, the echogram window is the principal interface used to display data for inspection, echo 
integration and analysis of backscattering strength or other properties. The colors within each column (ping) 
vary according to the value of each data sample within the ping. A standard echogram presents volume (Sv) or 
point (TS) backscatter information. Other acoustic, or virtual acoustic data may also be displayed as 
echograms. 

Virtual acoustic data is created by applying an operator (a mathematical or other algorithm) to one or more 
input acoustic variables.  

The Dataflow window tool   is used to manage and show the relationships between raw and virtual 
variables, geometry objects like platforms and transducers, and 3D objects in an EV file. Virtual lines are 
introduced in Topic 4: Lines and various virtual acoustic variables are discussed in other Echoview tutorials. 

Working with echograms 

1. Launch Echoview from the Start menu or by double-clicking the Echoview icon on the Desktop, which is 
created during installation. 

2. On the Welcome page, click on the Open an EV file option located at the right of the screen. This opens 
the file explorer window. 

3. Browse to the folder in which you extracted the tutorial files, and open GettingStarted_Topic1.EV. 

Echoview will close the explorer window and display the 50 kHz Fileset1: Sv pings echogram shown in 
Figure 1. 

 

Figure 1.  A screenshot of an echogram from GettingStarted_Topic1.EV. The Details and Message dialog boxes are also 
displayed at the left and bottom of the screen, respectively.  
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Echogram data values 

Immediately above the echogram window is the Information tool bar (Figure 2) showing the ping number, 
sample depth and sample value corresponding to the pixel beneath the mouse pointer on the echogram. The 
Color display minimum value is also shown. 

 

Figure 2. The Information toolbar showing ping number (679), sample depth (190.26 m) and sample value (-43.53 dB) for 
the pixel (ping sample) beneath the mouse pointer. The Color display minimum value (-70.00 dB) is also given. 

Other useful information can be found in the Details dialog box (left most panel in Figure 1) and the Status bar 
at the bottom of the window (Figure 3). Move the mouse pointer over the echogram and observe the changes 
on the Information toolbar, the Details dialog box, and the Status bar. 

 

Figure 3. Echoview status bar showing the name of the active line (Bottom depth), its depth/range (depth: 249.00 m), the 
status (Good) of the active line on the same ping as the selected sample, a Message reminder, the data file name 

(96082827.ELD), the coordinates (42o 15.463' S 145o 18.675 E) and date/time (28-Aug-96 04:49:41.1100) at which the 
ping was recorded. 

Color scheme 

Echoview uses colors to represent the value of each data sample in an echogram. It includes many standard 
color schemes and allows you to create custom color schemes. The Color display minimum and Color 
display range variables can be adjusted to suit the dynamic range of the echogram. 

To see what value a color represents you can check the Color Legend (the multi-colored bar Figure 1). For 
example, samples with a value in the range -70dB to -66dB will be displayed in turquoise. 

4. In Echoview, click in the 50 kHz Fileset1: Sv pings echogram window to bring it into focus. 

5. Press the = and - keys on the keyboard (not on the number pad) to increase or decrease the Color display 
minimum setting. The colors in the echogram and the Color Legend change as the setting is adjusted. 
Samples with a value below the Color display minimum value are displayed in the color at the bottom of 
the Color Legend (white in Figure 1).  

6. Press Y. The color scheme changes to the alternate palette for the selected color scheme.  

7. Press Y again to revert to the primary color scheme. 

8. Right-click on the Color Legend to access the Shortcut menu. You can change the color scheme, toggle 
the alternate color scheme, and change the display settings from this menu. 

 

Tips 

• There are many shortcut key combinations in Echoview to make data processing more efficient. Refer to 
the following pages in the Help file for a full list of shortcuts as well as instructions on how to customize 
shortcuts: 

o About keyboard shortcuts 

o Echogram keyboard shortcuts 

o User-defined keyboard shortcuts 

• If a Shortcut (right-click) menu item has a corresponding keyboard shortcut, it will be shown to the right of 

the item:  
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Navigating 

Zooming 

Echoview provides a variety of tools to zoom into an echogram. These include the: 

• mouse wheel 

• zoom icons on the toolbar   

• zoom commands on the Shortcut (right-click) menu 

• keyboard shortcuts 

The zoom level of the echogram is displayed as a ratio in the echogram tab along with its title. For example 

the zoom level of the 50 kHz Fileset1: Sv pings echogram in Figure 1 is [2:1]. 

Zooming in 

1. Click on the 50 kHz Fileset1: Sv pings echogram to bring it into focus. 

2. Click on the Rectangle  tool on the toolbar to select it, or press 1. 

3. Click and drag on the echogram to form a rectangular selection like the one in Figure 4. 

 

Figure 4. A selection in an echogram made using the Rectangle tool. 

4.  On the Shortcut menu (right-click), click Zoom In. 

 

Figure 5. Zoomed into a selection in an echogram. 
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Zooming out 

5. On the Shortcut menu (right-click), click Zoom Out to zoom to the previous level. 

6. On the Shortcut menu (right-click), click Unzoom to zoom out to the minimum zoom level. 

Zooming with the mouse wheel 

7. With the mouse pointer over the echogram, scroll the mouse wheel to zoom in and out. You will be able to 
zoom out to a maximum [1:1] ping to pixel ratio. 

Hold down the Ctrl key and use the mouse wheel to zoom out beyond a [1:1] ping to pixel ratio. 

Scrolling 

Vertical and horizontal scroll bars at the right and bottom edges of the echogram window can be used to 
reposition the area of the echogram currently in view. 

1. Use the Rectangle  tool to create a selection and zoom in on part of the echogram. 

2. Use the horizontal and vertical scroll bars to move around the echogram. 

3. Drag the boundaries of the echogram window to resize 

Arranging windows 

Every window such as the 50 kHz Fileset1: Sv pings echogram or Filesets windows (see Figure 1) can be 
repositioned or left to float in the Echoview workspace. 

1. Left-click the mouse and drag the title bar corresponding to the 50 kHz Fileset1: Sv pings echogram. 
Reposition the window in the Echoview workspace. In the figure below, the translucent blue rectangle 

shows the position of the floating window. Translucent docking guides  indicate where the floating 
window can be snapped. 

2. Drag the floating window to one of the docking guides  and release it to snap the 50 kHz Fileset1: Sv 
pings echogram to that position. 

3. Repeat steps 1. – 3. to practice rearranging windows in different configurations. 

  

Further information 

• Read the Navigating Echoview page in the Help file. 

• Echoview installs a file called Echoview shortcuts.cfg that specifies some of the default keyboard 

shortcuts that Echoview uses. This file can be modified to customize keyboard shortcuts. For more 
information, refer to the User-defined keyboard shortcuts page in the Help file. 

Figure 6. Blue translucent shape indicating the size and position of a floating window, and window placement guides. 
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• Some Echoview actions are available to the Undo or Redo features. 

• You can flip the echogram so that depth or range reads from the bottom-up via a setting on the Display 
page of the Variable Properties dialog box. This is useful for echograms of upward facing transducers. 

• Use the Mouse pointer duplication tool  to mirror the mouse position in multiple open echogram 
windows. 

 

Closing an EV file 

Before moving onto the next topic, you should close GettingStarted_Topic1.EV without saving 

changes. 

1. On the File menu, click Close. 

2. Click No when prompted to save changes to the EV file. 

3. This will return you to the Echoview Welcome page. 
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Topic 2: Understanding Cruise Tracks 

In this topic you will learn how to: 

• display a cruise track 

• display a map 

• navigate around the cruise track window 

Overview of cruise tracks 

A cruise track is a graphical representation of a connected series of GPS coordinates (known as GPS fixes in 
Echoview) collected at the same time as the ping data. 

Working with cruise tracks 

1. Launch Echoview. 

2. On the Welcome page, click on the Open an EV file option located at the right of the screen. 

3. In the explorer window, browse to the tutorial files folder and open GettingStarted_Topic1.EV. 

Echoview will now display the 50 kHz Fileset1: Sv pings echogram shown in Figure 1. 

4. Click on View in the toolbar and navigate to Cruise Track, position GPS fixes. This opens the Fileset 1: 
position GPS fixes window (Figure 7), which is an example of a cruise track. 

5. You may close the 50 kHz Fileset1: Sv pings echogram and Filesets windows by clicking on the  icons 
on the respective tabs. 

 

Figure 7. The Fileset1: position GPS fixes window displays a cruise track. The Platform icon  points and moves in the 
direction of travel. 

 

Loading maps 

Echoview allows you to load map files into the cruise track window. 

6. On the View menu, click EV File Properties, or press F6. 

7. Click the Mapping tab (Figure 8). 
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Figure 8. The Mapping page of the EV File Properties dialog box. 

 

8. Scroll down to the Map and waypoint files section. Click Add... to open the Add Map File explorer 
window. 

9. Select tasmania2pts.MIF and click Open to close the explorer window and return to the EV File 

Properties dialog box (Figure 8). 

10. Click OK on the EV File Properties dialog box. 

11. Use the navigation tools to view the map of Tasmania (Figure 9), Macquarie Harbour (Figure 9) or the 
cruise track (Figure 10). 
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Figure 9. The Fileset1: position GPS fixes window Cruise Track window showing Macquarie Harbour on the map of 
Tasmania (left), and the zoomed window (right). 

Synchronizing echograms with a cruise track 

Echoview allows you to synchronize the pings in an echogram with the GPS fixes in a cruise track with the 

versatile Mouse pointer duplication tool .  

12. From the View toolbar menu select Echogram, Sv pings. 

13. Arrange the 50 kHz Fileset1: Sv pings echogram and the cruise track windows so that they are displayed 
side by side. 

14. Select the Mouse pointer duplication tool .  

15. Point to the start icon of the cruise track (42° 15.0' S 145° 18.0' E in Figure 7) and from the Shortcut 
(right-click) menu, click Synchronize. The result is Figure 10.  

16. The mouse pointer platform motion in the cruise track window is duplicated in the echogram. A new cross 
hair position is displayed in response to each use of Synchronize. Away from the Start icon, the cruise 
track cross hair generally corresponds to the center ping in the echogram window. 

 
Figure 10. The Mouse pointer duplication tool is active, an echogram is on the right, a cruise track window is on the left. 

The Platform icon and crosshair are positioned at the cruise track Start icon. The Mouse pointer dashed line is on the ping 
of the cruise track Start icon. 
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Further information 

• The Vertical band tool enables you to make a selection on a cruise track and define regions. For more 
information, refer to the Using cruise tracks – Define a region page in the Help file. 

• To remove a map file from your EV File: 

a. Open the EV File Properties dialog box (press F6) 

b. Click the Mapping tab (Figure 7) 

c. Select the map and click Remove 

d. Click OK on the EV File Properties dialog box 

• To store a map in your EV File, but remove it from the cruise track window: 

a. Follow the procedure to Load the map into Echoview 

b. Focus the cruise track window and open the Variable Properties dialog box (press F8) 

c. Click the Cruise Track Display page. 

d. Clear the map in the Map display section. 

e. Click OK. 

• An alternative GPS processing method (to account for initial bad fixes) is available on the Data page of the 
cruise track Variable Properties dialog box. 

• The Echoview status bar displays the calculated area of a rectangular or polygon selection made in a 
Cruise Track window. Refer to the Echoview Help file page Using cruise tracks for more information. 

• Echoview supports ESRI shapes. 

• The Mouse pointer duplication tool  is supported by these open window types: echograms, cruise 
tracks, along track displays, line-referenced echograms and some graphs. Refer to the Help file, 
Echogram navigation: Mouse pointer duplication. 

• The Cruisetrack Display page of the EV File Properties dialog box displays the default settings for the 
cruise track, GPS fixes, GPS grid and background. 

 

Before moving onto the next topic, you should close GettingStarted_Topic1.EV without saving 

changes. 

1. On the File menu, click Close. 

2. Click No when prompted to save changes to the EV file. 

3. This will return you to the Echoview Welcome page. 

 

Topic 3: Files and Filesets 

In this topic you will learn: 

• about the Filesets window 

• how to load data files into Echoview 

• about EV files 

• how to work with EV files  

Working with data files and filesets 

Definitions 
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Data file Files of data logged from echosounders and other equipment. Data files are usually primary 
information archived from a survey. Echoview does not modify data files. 

Variable A time-series of measurements of one data type. An acoustic variable, where the data is made 
up of pings, can be displayed as an echogram. A position variable, where the data is made up 
of GPS fixes, can be displayed as a cruise track. Refer to the About variables page in the Help 
file for a full list of variables used by Echoview 

Fileset A collection of data file(s) and the variable(s) derived from those data file(s). These are 
grouped together in the Filesets window (see Figure 11). 

 

The Filesets window 

The Filesets window is used to manage filesets, data files and variables. It can contain a single fileset or 
multiple filesets. Each fileset will be displayed on a separate tabbed page within the Filesets window. 

1. Launch Echoview. 

2. On the Welcome page, click on the Open an EV file option located at the right of the screen. 

3. In the explorer window, browse to your tutorial folder and select GettingStarted_Topic4.EV. 

Echoview will now display the 50 kHz Fileset1: Sv pings echogram  

4. On the toolbar click on the View menu and select Filesets to display the Filesets window (Figure 11) or 
press F10. 

The Filesets window has three distinct sections 

• Data Files at the top displays the name and folder of the data file(s) that have been added to the current 
fileset as well as the time of the earliest and latest ping in each data file. 

The fileset for the EV file in Figure 11 contains two data files and three raw variables (Sv pings, position 
GPS fixes and a line data sounder-detected bottom). 

• Calibration file input section, in the middle, displays the calibration file used for the fileset, if one has been 
specified. Buttons enable you to browse to add, remove or edit a calibration file. 

• Raw Variables section, at the bottom, displays raw variables (Sv, TS, telegrams/tuples and other 
measurements) that Echoview has derived from the data file(s). 

Raw variables can be organized with the Transducers button or the (variable) Types button 

Raw variable data may be opened via Window shortcut buttons. For example, the Sv pings variable data 
may be displayed in the window types: Echogram or alongtrack Cruisetrack or Table or Variable 
Properties. Whereas position GPS fix variable data could be viewed as a Cruisetrack, Table or Variable 
Properties. 
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Figure 11. The Filesets window. 

Adding multiple data files 

Echoview allows you to add multiple data files of the same type to a fileset. For example, multiple data files 
from the same survey. When Echoview detects common data types in these files it derives a single raw 
variable that incorporates measurements from these files. This allows you to view data that was logged in 
multiple data files as a single echogram, and to analyze data in multiple data files through a single variable. 

Tips  

• For further information about the Filesets window refer to the following pages in the Help file: 

o About the Filesets window 

o Filesets window shortcuts 

• You can copy data file paths from the Filesets window. 

• Problems in data files are flagged when they are first added to the Filesets window. Flags appear as 
messages in the Messages dialog box. 

• Echoview supports large data files. 

• You can use Echoexplore to find and catalog compatible echosounder and sonar data files on your 
computer. You can download Echoexplore from the Echoview website. 

Before moving onto the next topic, you should close GettingStarted_Topic4.EV without saving 

changes. 

1. On the File menu, click Close. 

2. Click No when prompted to save changes to the EV file. 

3. This will return to the Echoview Welcome page. 

 

Working with EV files 

EV files are created in Echoview and are used to organize data files and filesets. 

You might create a single EV file containing all the data for a complete survey, an EV file for each transect of a 
survey, or an EV file for each day of a survey. 

See the About EV files page in the Echoview Help file for more information on EV files. 

Creating an EV file 

5. Launch Echoview. 

https://echoview.com/products-and-services/echoexplore/
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6. On the Welcome page, click on the File menu in the toolbar and select New. You may also click on the 

 icon in the tool bar, or press Ctrl+N. The Dataflow and Filesets windows are displayed. (If the New EV 
File dialog box is displayed, click No Template.) 

Adding data files to an EV file 

7. In the Filesets window, click Add to open the Add Data Files explorer window. 

8. Select the data file DemoData.ek5 and click Open. This closes the explorer window and displays the 

DemoData.ek5 file in the Data Files section of the Filesets window. This data file contains 14 raw 

variables that are listed in the Raw Variables section (see Figure 12) arranged with respect to 
Transducer. 
 
You can add other .ek5 files to this fileset (for example data files from earlier or later in the same survey). 
Echoview would add the pings from those files to existing variables. This allows you to view a continuous 
pings in a single echogram rather than separate echograms for each data file (see Adding multiple data 
files). 

 

Figure 12. The Filesets window with the Demodata.ek5 data file added. 

Displaying the echogram of a variable 

9. In the Raw variables section of the Filesets window, click Sv Q1 telegrams T1 (316 pings) to select it. 

10. Click  to display the echogram of Sv Q1 telegrams T1. 



 

Echoview Tutorial: Getting Started Page 16 of 31 

 

Figure 13. Echogram of the Sv Q1 telegrams T1 variable 

11. In the Raw variables section, click Sv Q2 telegrams T2 (316 pings) and click . Echoview 
displays the echograms for the Sv Q1 telegrams T1 and Sv Q2 telegrams T2 variables simultaneously. 

Multiple echograms can be displayed in Echoview in this way. 

Saving an EV file 

12. On the File menu, click Save As to open the Save As explorer window. 

13. Navigate to the tutorials folder. 

14. Enter GettingStarted_Topic3 in the Filename text field. 

15. Click Save. Echoview automatically adds the .EV file extension when you save the file. 

Saving your workspace 

Your workspace remembers the windows that are displayed in Echoview together with their positions and 
contents. Echoview can save this workspace in the EV file. 

16. Adjust the borders between the windows that are open. 

17. Zoom into a part of the Sv echogram 

18. On the File menu in the toolbar, click Close. 

19. On the File menu, click Exit. 

20. Launch Echoview. 

21. On the Welcome Screen, under Recent files click on GettingStarted_Topic3. Echoview opens the 

EV file, and displays the workspace as you left it. 

22. On the View menu, open the EV File Properties dialog box by selecting EV File Properties. 

23. Click the EV File tab. Under the Workspace section, use the When EV file is opened list to configure the 
Echoview workspace behavior. 

24. The workspace is saved in the same folder as your EV file with an .evwx extension. 

 

Close GettingStarted_Topic3.EV without saving changes. 

1. On the File menu, click Close. 
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2. Click No when prompted to save changes to the EV file. 

3. This will return you to the Echoview Welcome page. 
 

Topic 4: Lines 

In this topic you will learn about the line tools available in Echoview. There are three kinds of lines in 
Echoview: 

• Raw lines are read from a data file, and cannot be edited or deleted. Examples include sounder detected 
bottom lines, depth lines and heave lines. 

• Editable lines are the most general line type in Echoview, and encompass all lines, other than raw and 
virtual lines. Editable lines are stored as a series of depth vs. time coordinates. They can be created, 
edited, and deleted. 

• Virtual lines are created from Line operators and may be seen on the Dataflow window  and the Line 

and Surface tool . 

More information is available on the About lines page in the Help file. 

Working with raw lines 

Sounder detected bottom line example 

Echoview can derive the recorded sounder detected bottom from most data files and displays it as a line on an 
echogram. These are raw lines and cannot be modified or deleted in Echoview. 

1. Launch Echoview. 

2. On the Welcome page click on the Open an EV file option located at the right of the screen. 

3. In the explorer window, browse to your tutorial folder and select GettingStarted_Topic4.EV. 

Echoview will now display the 50 kHz Fileset1: Sv pings echogram. 

4. In Echoview, click in the 50 kHz Fileset1: Sv pings echogram window to bring it into focus. 

5. Open the Shortcut menu (right-click) and select Variable Properties. 

6. Click the Lines page. 

7. Toggle the checkbox for Fileset1: line data sounder-detected bottom and click OK. This closes the 
Variable Properties dialog box and displays the sounder detected bottom line in the echogram. This is 
shown in Figure 14. 

By default, the sounder detected bottom line appears as a thin yellow line. It lies immediately above the 
bottom, that is seen as a green, unbroken, and upward sloping region across the middle of the echogram.  

A close look at the sounder detected bottom line reveals that it is inaccurate. In this example, it has jumped to 
the second bottom echo at the bottom right of the echogram. Depending on the current zoom settings in 
Echoview, you may need to navigate to the right of the echogram to see this. 

As the sounder detected bottom is a Raw line it cannot be modified. To fix this problem, we can create a new 
editable line that is sourced from the sounder detected bottom and modify that instead. We explore this 
technique with another example in the Creating lines using a line pick algorithm section. 
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Figure 14. The sounder detected bottom line on the Sv pings echogram is shown in yellow. 

Changing line display thickness and color 

For increased clarity, Echoview allows you to specify custom line thicknesses and line status colors. 

8. Click on the sounder detected bottom line. 

9. On the Shortcut menu (right-click) and select Line Properties to open the Line Properties dialog box. 

10. Click the Display page and select the Custom button. 

11. This page allows you to change the line thickness and colors. 

Individual colors describe the state of the line: Good, Bad or Uncertain – usually set by certain threshold 
properties intrinsic to the line segment. Change these by clicking on the colored squares to access the 
palette options. 

Click OK to implement the changes and close the Line Properties dialog box. 

Working with editable lines 

Overview of editable lines 

Echoview allows you to create editable lines by: 

• using a line pick algorithm to detect the bottom 

• specifying a line at a fixed depth 

• applying an offset (linear or angular) to an existing line 

• drawing a free-form line by hand 

In this section we will introduce creating lines using two examples. 

The first uses a line pick algorithm to detect the bottom. 

The second specifies a line at a fixed depth. 

Refer to the About lines page in the Help file and links within for information on using the other methods. 

Line pick algorithm example to detect the bottom 

In this exercise, you will create a new line using the line pick algorithm to detect the bottom. This algorithm is 
tuned for echo integration and will create a line that is just above the bottom echo. 

It will also demonstrate how to fix the problem with the sounder detected bottom line that we encountered in 
the Sounder detected bottom line example. 
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12. On the toolbar, click on the ▼icon on the Line and Surface  button to open the menu, and 
then click New Editable Line. 

Alternatively, 

o click the Dataflow  icon in the toolbar to open the Dataflow window 

o in the Dataflow window, click Fileset1: SV pings to select this variable 

o on the Shortcut (right-click) menu for Fileset1: SV pings, point to New, and click Editable Line 

The New Editable Line dialog box is displayed (see Figure 15). 

 

Figure 15. The New Editable Line dialog box. Clicking on Help at the bottom right of the dialog box will open the New 
Editable Line dialog box Help page, where you can learn about the options in this dialog box. 

13. Under the Destination section, click on the Create a new line: button. In this example we will call the new 
line: New Bottom. 

14. Under the Source section, click on the Pick from current variable button. 

15. Click the Span gaps checkbox. This bridges any gaps between disjointed line segments. 

16. Click OK to close the New Editable Line dialog box and display New Bottom as a green line on the 
echogram (see Figure 16). 

 

Figure 16. The active New Bottom line as a running line. 
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Navigate the echogram to see how New Bottom and the sounder detected bottom line compare in handling 
the second bottom echo. 

Fixed depth line example 

Lines can also be created to span a fixed depth across an echogram. A practical use for such a line could be 
to exclude the region of an echogram that is corrupted by transducer ringing (see the Transducer ringing page 
in the Help file). 

To find the depth to which the transducer ringing is saturating the echogram: 

17. Zoom out of the echogram until the top is visible. 

18. Click the Rectangle  tool on the toolbar and use the cursor to make a rectangular selection at the top 
of the echogram. 

19. Zoom in on the selection.  

20. Adjust the Color display minimum until it is -79dB. 

21. You should see something that resembles Figure 17. If not, repeat steps 18. – 21. 

 

Figure 17. Echogram showing high sample values (the blue-gray band) in the first 2 meters. 

22. The solid band at the top of Figure 17 corresponding to -67dB indicates the extent of transducer ringing. 
Use the mouse to point to the base of this band to obtain the depth from the Information tool bar (Figure 
2). It should correspond to a depth of 2 meters. 

We can now create a fixed depth line. 

23. On the toolbar, click on the ▼icon on the Line and Surface  button to open the menu and 
then click New Editable Line. 

Alternatively, 

o click the Dataflow  icon in the toolbar to open the Dataflow window 

o on the Shortcut menu (right-click) in any empty region, point to New, and click Editable Line 

24. Under the Destination section, click on the Create a new line: button. You can assign a name to your 
new editable line by entering it into the text field. In this example we will call it: Fixed depth line. 

25. Under Source, click the Fixed depth (m): button and enter 2.5 into the text field. 
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26. Click OK to close the New Editable Line dialog box and to see the Fixed-depth line on the echogram 
(Figure 18). 

 

Figure 18. Echogram showing “Fixed-depth line” at a depth of 2.5 meters. 

Making modifications to editable lines 

Editable lines can be modified. In this exercise, you will learn how to modify the line created in the Line pick 

algorithm example to detect the bottom exercise. 

27. Adjust your echogram window until you see the view in Figure 19. 

 

Figure 19. Echogram showing selection to be zoomed. 

28. Use the Rectangle tool  on the toolbar to select the region shown in Figure 19, and zoom in. The 
echogram should resemble the image in Figure 20. 

 

Figure 20. The Fileset1: SV pings echogram zoomed in over selection shown in Figure 19. 
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29. On the toolbar, click on the ▼icon on the Line and Surface  button to open the menu. 

30. On the menu, select New Bottom (see Figure 21). This is now the active line to which your edits will be 
applied. 

 

Figure 21. The Line and Surface tool’s menu with the New Bottom line selected. 

31. Using the left mouse button, progressively click (or click and drag) from left to right over the artefact that 
appears to be just above the bottom (see Figure 22). Note: The line edits you make can be finer than 
single pings and single-sample depths. 

 

Figure 22. Echogram showing line drawing over bottom object. 

32. At the end of the final stroke, release the left mouse button, activate the Shortcut (right-click) menu and 
click Update Active Line. The line will be redrawn over the object as shown in Figure 23. 
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Figure 23. Echogram showing the redrawn line. 

Read the Creating, editing, renaming and deleting lines page in the Help file for more information on modifying 
editable lines. 

Working with virtual lines 

Overview of virtual lines 

Virtual lines are lines that are defined relative to any other editable, raw, or virtual line. Any modifications to the 
reference line will also be reflected in corresponding Virtual line(s). To follow this example in Echoview, first 
complete the Line pick algorithm example to detect the bottom exercise. 

Creating virtual lines 
In this example you will create a virtual line that is offset by 10 meters from the New Bottom line. 

33. Right-click on the echogram to access the Shortcut menu and click Unzoom. 

34. On the toolbar, click on the ▼icon on the Line and Surface  button to open the menu then 
click New Virtual Line.  

Alternatively, 

o click the Dataflow  icon in the toolbar to open the Dataflow window 

o open the Shortcut menu using right-click in any empty region, point to New, and click Virtual 
Line. 

This opens the New Virtual Line dialog box. 

35. Under the Select operator section, click on Linear offset, click OK. 

36. In the Line Properties – Linear offset [multiplied by 1.0 plus 0.0m] dialog box, on the Operands page, 
under Operand 1, select New Bottom from the list. See Figure 24. 

37. On the Linear Offset page, set Multiply depth by to 1.0 and Then add (m) to -10. 

38.  On the Name and Notes page, the line name is given by the Dynamic name. Update the Dynamic name 
text ‘Linear offset’ to New bottom. 

39. Click OK.  
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Figure 24. Line Properties dialog box. 

40. The virtual line is displayed as a green line 10 meters above New Bottom. 

 

Figure 25. An echogram displaying a virtual line 10 m above the acoustic bottom line. 

Try editing the New bottom line and observe that the New bottom [multiplied by 1.0 plus -10 m] line 
automatically updates. 

Choosing which lines are visible on an echogram 

Lines are stored in the EV file. As such, they are available for use across all echograms. In this section, you 
will learn how to choose which lines are displayed in an echogram. To follow this exercise in Echoview, first 
complete the Sounder detected bottom line example. 

41. Bring the 50 kHz Fileset1: Sv pings echogram into focus by clicking on it. 

42. In the toolbar, click on the Echogram menu, then click Variable Properties open the Variable Properties 
dialog box. 
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43. Click the Lines tab (see Figure 26). 

 

Figure 26. The Lines page of the Variable Properties dialog box. 

 

44. Clear the checkbox for Fileset 1: line data sounder detected bottom by clicking on it. 

45. Click OK to save the changes and close the Variable Properties dialog box. The sounder detected bottom 
line is no longer displayed on the echogram. 

Further information 

• Raw lines include sounder detected bottom lines and line data read from data files. Raw lines can 
represent depths from a sensor (trawl or other types of depth information) or heave. Raw lines cannot be 
edited but you can derive editable lines from raw lines, which can be modified instead. 

• Virtual lines are derived from a Line operator. There are virtual line operators that are equivalent to 
editable line types and line manipulation operators that can line pick, crop, combine, or filter lines. 

• There are several line pick algorithms available. The line pick algorithm is specified under EV File 
Properties: Lines and Surfaces. A line pick is started using Pick New Line from the Shortcut menu.  

• The color and thickness of any line can be customized in the Line Properties dialog box. 

• For more information about lines, line settings and line uses, refer to the About lines page in the Echoview 
Help file. 

• Dynamic names are made up of plain text and special text that responds to changes in selected settings. 
For further information refer to the Help file, Dynamic name on the Name and Notes page of the Line 
Properties dialog box page. 

Before moving onto the next topic, close GettingStarted_Topic4.EV file.  
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It is recommended that you save the file with a different name (using Save As) so you can repeat the default 
exercises on this topic in the future. 
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Topic 5: Selections and Regions 

In this topic you will learn how to make selections and create and edit regions. 

Overview 

Selections and regions are the specific areas of an echogram that you define using the  

 tools in Echoview. They are useful for: 

• placing visual markers on an echogram 

• defining areas in the echogram for on-screen analyses 

• defining areas in the echogram for export analyses 

• defining areas to be excluded for analyses (example noise) 

Note: This topic does not cover all the uses for Selections and Regions. For more information, refer to the 
Introduction to Integration and the Introduction to Fish Tracking tutorials and the Help file. 

Working with Selections 

Selections are transient areas that can be used for on-screen analyses, to define regions, to select the single 
targets to include in a fish track and more. 

1. Open the GettingStarted_Topic4.EV file. 

2. Display the 50 kHz Fileset 1: Sv pings echogram and bring it into focus by clicking on it.  

3. If there is no grid on the echogram, open the Variable Properties dialog box for the Sv pings variable with 
F8. 

4. Select the Grid page and the settings: 

o Show time/distance grid = Time (minutes). 

o Time between grid lines = 10.0 

o Show depth/range/line-referenced grid = Water surface (depth of zero). 

o Separation (m) = 150.0 

5. Click OK. 

Making selections using the Horizontal band tool and Vertical band tool 

The Horizontal band  and Vertical band  tools allow you to make rectangular selections that span the 
entire horizontal and vertical dimensions of an echogram. 

6. Click the Horizontal band tool. 

7. Move the mouse pointer to a depth of approximately 200 meters on any ping on the echogram. The depth 
of the sample at which the mouse pointer is pointing is displayed in the Information tool bar. 

8. Click and drag the cursor to depth of approximately 250 meters. 

9. Release the mouse button. A horizontal selection is created between the depths of 200 meters and 250 
meters. 
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Figure 27 A horizontal selection on an echogram. 

10. Use the horizontal scroll bar to scroll to the right. You will notice that the selection spans the entire 
echogram. 

The Vertical band tool works in a similar way but defines a selection in the vertical dimension. 

Making selections using the Parallelogram tool 

The Parallelogram  tool allows you to make selections of a fixed thickness using the mouse. 

In the following example, you will create a selection with a thickness of 15 meters that follows the bottom of 
the echogram.  

11. To improve the color scheme contrast, right-click on the Color legend and change the Color scheme to 

Magma. Use the horizontal scroll bar to display the far left of the echogram. Use the Zoom In tool  
once. 

12. Click the Parallelogram tool. 

13. Move the mouse pointer to a depth of 330 meters at the far left of the echogram. 

14. Click and drag on the echogram until the mouse pointer is just above the bottom line (approximately 300 
meters) then release the mouse button. Note: This sets the initial height of the parallelogram, which will be 
used for the entire selection. 

15. Move the mouse to the point in the echogram just above the bottom where the gradient of the bottom first 
changes (at approximately 4:52:00). 

16. Click just above the bottom at this point. The first section of the parallelogram selection is drawn. 

 

Figure 28. The first part of the parallelogram selection is shown. 

17. Position the mouse pointer so it is just above the bottom at the point where the gradient of the bottom 
changes again. 
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18. Click left mouse button. The second section of the parallelogram selection is drawn. 

19. Position the mouse pointer so it is just above the bottom of the echogram at the right most point that is 
currently displayed in the echogram window. 

20. Click the left mouse button. Another section of the parallelogram selection is drawn. 

21. Repeat step 17 further along the echogram as required. 

22. If you want to retain the selection, right-click on the Shortcut menu, select Define region. Otherwise, 
proceed onto the next section. 

Making selections using the Polygon tool 

The Polygon  tool allows you to make selections of any almost shape using a free-hand drawing tool. 

23. Click the Polygon tool. 

24. Click and drag to create a shape of your choosing (for example, draw a selection around a school). 

25. When you are ready to close the polygon, on the Shortcut (right-click) menu select Define Region. 

  

Figure 29. A polygon selection on an echogram 

Figure 29: . 

Tips 

• Echogram windows remember their active tools. 

• Left-clicking anywhere on the echogram closes any selection that you have made.  

 

Working with Regions 

Overview of regions 

Defined regions are selections that persist and can be used for many purposes in Echoview, including: 

• placing visual markers on an echogram 

• on-screen analysis  

• identifying part(s) of an echogram to include in analyses 

• identifying part(s) of an echogram to exclude from analyses 

• defining fish tracks 

• defining schools. 

Echograms can be synchronized to the active region. On-screen analysis results can be linked to an active 
region. 

Region types 
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Echoview has five region types 

Analysis A part of an echogram that you can analyze separately from other parts of 
the echogram. 

Bad data (no data) A part of an echogram that is unwanted and which can be handled in a 
specific way during analysis. 

Bad data (empty water) A part of an echogram that is unwanted and which can be handled in a 
specific way during analysis. 

Marker A part of an echogram that is of interest and, therefore flagged to be 
handled in a special way. This is neither bad data nor data that needs to be 
analyzed separately from other parts of the echogram. 

Fish track A selection of closely associated single targets that are assumed to have 
been generated by one fish. 

Note: Fish-track regions are a special class of region and some of the 
information/procedures described in this topic do not apply. Fish-track 
regions are covered in more detail in the Introduction to Fish Tracking 
tutorial. 

Note: Aside from region types, Echoview also allows you to create region classes. Read the About region 
class page in the Echoview Help file for further information. 

Creating Regions 

You create regions from selections. In this exercise you will create an analysis region using the Rectangle tool, 
though you may use any of the selection tools introduced in [this section]. 

26. Right-click on the Color legend and change the Color scheme to EK500. 

27. Click the Rectangle tool  on the toolbar. 

28. Select an area of interest on the echogram. 

29. From the Shortcut (right-click) menu, click Define Region. The region is defined in a translucent 
rectangular box, and the Region Browser dialog box pops up at the bottom of the Echoview interface (see 
Figure 30). 

 

Figure 30. A region is defined in a translucent rectangular box on the echogram, and the Region Browser dialog box pops 
up at the bottom of the Echoview interface. 
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30. Label the region by entering a name into the Name: text box. In this example, we call it: Test region. This 
change is reflected in the label in the echogram during pauses in your typing. 

31. Under the Type list select Analysis. This changes the color of the region in the echogram. Note: Echoview 
assigns a different color to each region type.  

32. Close the Region Browser dialog box by clicking on . This does not affect the regions that have been 
defined. 

 

Editing region properties and shape 

Once you have created a region you can change its properties (for example its name and type) or shape. 

You can change the properties of a region using the Region Browser dialog box. To display the Region 

Browser dialog box, select the region and click the Region Browser  icon in the toolbar. You may need to 

click on the More buttons  icon if the Region Browser icon is hidden. 

Echoview allows you to change the shape of a region in three ways: 

• by moving the nodes (anchor points) of the region 

• by redrawing parts of the region boundary 

• by nudging the region boundary into the desired shape 

You can toggle between these by clicking on the Region edit  icon in the tool bar. Read the Editing 
regions page in the Help file for instructions on using each of these. 

 

Tips  

• Region properties include a Notes page where you can input plain text 

• You can export a logbook of regions (including their notes and locations) to a csv file by opening the 
Echogram menu and selecting Export then Regions then Log Book. 
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